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Environmental Services Commission
June 9, 2022
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Template Read-MeDo not insert animations or slide transitions into your presentation.Use only sans serif fonts (i.e.: Arial, Tahoma, Helvetica).Fonts must be between 24 points and 32 points in size. The minimum point size allowed is 18. Avoid having too much text. If the text flows outside the safe title area, split the information into two or more slides.Pictures with white backgrounds should be toned down by right clicking the mouse on the picture, then selecting Format Picture, lower the brightness by 10%.Ensure graphics (pictures, charts) are high resolution so they can be easily viewed on screen.The Safe Area grid lines that you see on the background should be removed when your presentation is completely formatted.To remove the grid lines: Select the View tab. On the left side of the upper tool bar, click on Slide Master. Select the top most slide in the list.  (You may need to scroll)To select the Safe Area we suggest clicking on the upper left corner of the object.  Once it highlights, press delete.  Save your presentation.Alternatively you may hide the Safe Area by clicking Hide Background Graphics in the Design tab for each slide in your presentation.  (However, make sure this action does not also affect other graphics you have added to your presentation.)
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Agenda

• Welcome
• Approval of Minutes
• Open Public Meetings Act Follow-up
• Baseline Budget for Next Biennium
• Other Items of Interest
• Adjournment
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• Updates to OPMA effective June 9:
o Accepted written public comment for 6/9 meeting
o Public comment language added to ESC 

website
o The public can subscribe to meeting 

notifications and can view agendas on website
• Potential amendment to by-laws (pending vote):

o Future meetings: In-person, virtual, or hybrid
o Public Comment: Written, oral, or both

Updates to Open Public Meetings Act
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Baseline Budget for Next Biennium

Presentation

Presenter: Christina Curran, Assistant Division Manager 
ES Rates & Budget
Email: ccurran@cityoftacoma.org
Phone: 253.691.9285

mailto:ccurran@cityoftacoma.org
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Budget Development Process

Baseline 
Budget

Budget 
Proposals

Proposed to 
Adopted 
Budget

Jan - April April – August* August - November

Budget Clean-
up

Six-Year 
Forecast

Proposal 
Approvals

Adopted 
Budget
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ES Budget Growth

Fund 2021-2022 Adopted 
Budget*

2021-2022 Current 
Budget*

2023-2024 Baseline 
Budget*

Solid Waste $133 M $139 M $157 M

Wastewater $152 M $155 M $173 M

Stormwater $63 M $66 M $77 M

*Excludes capital budget
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ES Baseline Budget Impacts

Category
Growth in 21-22 Biennium 
(Adopted versus Current)

Projected Growth from 
2022 Adopted to 2023

Projected Growth from 
2023 Adopted to 2024

2021-2022 Current versus 
2023-2024 Baseline

Personnel 1% 0% 5% 5%
Assessments NA 12% 6% 17%

GG Internal Service Costs NA 12% 5% 17%
GG Internal Service Costs - IT NA 4% 9% 10%
TPU Internal Service Costs NA 22% 4% 25%

Other 3% 12% 2% 15%
Total Change 2% 7% 3% 12%

    
  

   
   

   
   

   
 

   
     
   

 

Wastewater Operating Expenses

  

    
  

   
   

   
   

   
 

   
     
   

 

Category
Growth in 21-22 Biennium 
(Adopted versus Current)

Projected Growth from 
2022 Adopted to 2023

Projected Growth from 
2023 Adopted to 2024

2021-2022 Current versus 
2023-2024 Baseline

Personnel 3% 14% 5% 19%
Assessments NA 23% 5% 27%

GG Internal Service Costs NA 26% 6% 32%
GG Internal Service Costs - IT NA 25% 7% 30%
TPU Internal Service Costs NA 21% 4% 24%

Other 4% 12% 0% 8%
Total Change 3% 14% 2% 14%

  

Stormwater Operating Expenses
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ES Baseline Budget Impacts

Category
Growth in 21-22 Biennium 
(Adopted versus Current)

Projected Growth from 
2022 Adopted to 2023

Projected Growth from 
2023 Adopted to 2024

2021-2022 Current versus 
2023-2024 Baseline

Personnel 1% 3% 4% 6%
Assessments NA 15% 5% 20%

GG Internal Service Costs NA 9% 5% 14%
GG Internal Service Costs - IT NA 19% 6% 26%
TPU Internal Service Costs NA 22% 4% 24%

Other 7% 4% 3% 15%
Total Change 4% 5% 4% 12%

Solid Waste Operating Expenses

IT overall expenses only 
increased 16% from 21-22 

Adopted to 23-24

TPU assessments include an 
increase of 16 FTEs
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Bill Credit Assistance Program PLUS

Solid Waste Wastewater Stormwater Solid Waste Wastewater Stormwater
Estimated Total Annual BCAP Plus Budget 196,807         254,842         124,274         406,734      578,559      248,547      
Current Annual BCAP Budget 100,000         80,000           40,000           100,000      80,000         40,000        
Difference (Needed Annual Increase) 96,807           174,842         84,274           306,734      498,559      208,547      

97% 219% 211% 307% 623% 521%

2023 2023 2023 2025 2025 2025
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Capital Cost Drivers
• Better data 

• Better understanding of current backlog and 

associated risk

• Better understanding of assets and needs

• Increased costs
• Inflation

• More complex street restoration

• Regulatory and design requirements

• Timing (system is aging)

• Growth

Planning for and addressing these increased costs will be a focus in the 2025-2026 rate cycle

Presenter
Presentation Notes
So far focus as been on operating budget, but as we’ve discussed previously capital costs are also rapidly increasingNotes:To offset lower than planned rate increases, ES deferred $26M in capital projects planned for 21-2026.During 2021, construction inflation increased construction costs so that ES deferred an additional $47M.ES just updated the CIP for 2023-2028 and though inflation is projected to begin decreasing, overall project costs are still high. The utility budget could not support the proposed CIP spend when the operating baseline budget was also updated, even with higher than historical rate increases.ES is now planning to defer an additional $49M ($23M Storm/$26 Wastewater) based on available funding. ES is having to eliminate non-critical utility projects and has limited ability to provide grant match and participate in PW partnership projects.
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Capital Cost Planning

$26M • Delayed as part of 
reduced rates for 2021-
2022 Adopted Budget

$47M
• Additional delays 

added to respond 
to 2022 
construction 
inflation

$49M
•Recently added 

delays to stay 
within baseline 
budget CIP 
allocation

$122 M 
in delayed projects 

since 2020

Presenter
Presentation Notes
So far focus as been on operating budget, but as we’ve discussed previously capital costs are also rapidly increasingNotes:To offset lower than planned rate increases, ES deferred $26M in capital projects planned for 21-2026.During 2021, construction inflation increased construction costs so that ES deferred an additional $47M.ES just updated the CIP for 2023-2028 and though inflation is projected to begin decreasing, overall project costs are still high. The utility budget could not support the proposed CIP spend when the operating baseline budget was also updated, even with higher than historical rate increases.ES is now planning to defer an additional $49M ($23M Storm/$26 Wastewater) based on available funding. ES is having to eliminate non-critical utility projects and has limited ability to provide grant match and participate in PW partnership projects.
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2020 Financial Forecast 

2021-2026 Six-Year Revenue Plan2021-2026 Six-Year Revenue Plan

*To help offset rate increases in out years, added $15M in debt to Solid Waste 
and decreased Wastewater and Surface Water capital spending by $26M.

Year Solid Waste Wastewater Surface Water
2021 1.5% 1.5% 1.5%
2022 2.0% 2.0% 2.0%
2023 4.0% 4.0% 3.0%
2024 4.0% 4.0% 3.0%
2025 3.5% 4.0% 3.0%
2026 3.5% 4.0% 3.0%
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						Year		Solid Waste		Wastewater		Surface Water

						2021		1.5%		1.5%		1.5%

						2022		2.0%		2.0%		2.0%

						2023		4.0%		4.0%		3.0%

						2024		4.0%		4.0%		3.0%

						2025		3.5%		4.0%		3.0%

						2026		3.5%		4.0%		3.0%
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2022 Financial Forecast 
2023-2028 Preliminary* Six-Year Revenue Plan

Year Solid Waste Wastewater Stormwater

2021 1.5% 1.5% 1.5%
2022 2.0% 2.0% 2.0%
2023 3.0 % (-1%) 7.0% (+3%) 5.0% (+2%)
2024 3.0 % (-1%) 7.0% (+3%) 5.0% (+2%)
2025 3.0 % (-0.5%) 6.0% (+2%) 4.0% (+1%)
2026 3.0 % (-0.5%) 6.0% (+2%) 4.0% (+1%)
2027 3.0 % 5.0% 3.5%
2028 3.0 % 5.0% 3.5%

*Subject to change based upon 2022 performance and updated 2023-2024 plan

Presenter
Presentation Notes
Financial forecast based on 2021 results. Still projecting high rate increases for CIP as well as increasing expenses.In Solid Waste for example, we anticipate expenses to increase 7% in 2022 from 2021. The projected increase is due to increasing contract costs (a trend continuing from 2021, a budget correction for fleet maintenance, a waste characterization audit, and four additional FTEs. Budget adjustments for 2022 were completed at the end of 2021 as part of the mid-biennium modification process.Expense growth assumptions include:Growth assumptions beginning in 2023 increase 3.5% general, 5% salaries, 4% benefits, and 4% utilities.
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2022 Financial Forecast 
2023-2028 Baseline Budget* Six-Year Revenue Plan

Year Solid Waste Wastewater Stormwater

2021 1.5% 1.5% 1.5%
2022 2.0% 2.0% 2.0%
2023 3.0 % (-1%) 7.0% (+3%) 5.5% (+2%) (+0.5%)
2024 3.0 % (-1%) 7.0% (+3%) 5.5% (+2%) (+0.5%)
2025 3.0 % (-0.5%) 6.5% (+2%) (+0.5%) 4.5% (+1%) (+0.5%)
2026 3.0 % (-0.5%) 6.5% (+2%) (+0.5%) 4.5% (+1%) (+0.5%)
2027 3.0 % 6.0% (+1%) 4.0% (+0.5%)
2028 3.0 % 6.0% (+1%) 4.0% (+0.5%)

*Subject to change based upon 2022 performance and updated 2023-2024 plan

Presenter
Presentation Notes
Additional rate increases to account for baseline budget cost increases
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•Updated 2023-2024 revenue requirement
•Includes budget proposals

• Environmental Services proposals
• Internal Service proposals

•Report back to ESC July 14th

•Final revenue requirement and rates 
August/September

Next Steps

Presenter
Presentation Notes
ISF proposal is why not increasing capital at this timeSolid Waste in unique position
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Environmental Services Commission
City of Tacoma | Environmental Services Department

Environmental Services Commission
Next Meeting: Thursday, July 14, 2022
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Presentation Notes
Template Read-MeDo not insert animations or slide transitions into your presentation.Use only sans serif fonts (i.e.: Arial, Tahoma, Helvetica).Fonts must be between 24 points and 32 points in size. The minimum point size allowed is 18. Avoid having too much text. If the text flows outside the safe title area, split the information into two or more slides.Pictures with white backgrounds should be toned down by right clicking the mouse on the picture, then selecting Format Picture, lower the brightness by 10%.Ensure graphics (pictures, charts) are high resolution so they can be easily viewed on screen.The Safe Area grid lines that you see on the background should be removed when your presentation is completely formatted.To remove the grid lines: Select the View tab. On the left side of the upper tool bar, click on Slide Master. Select the top most slide in the list.  (You may need to scroll)To select the Safe Area we suggest clicking on the upper left corner of the object.  Once it highlights, press delete.  Save your presentation.Alternatively you may hide the Safe Area by clicking Hide Background Graphics in the Design tab for each slide in your presentation.  (However, make sure this action does not also affect other graphics you have added to your presentation.)
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